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SOFTWARE LICENSE AGREEMENT 
 

This license agreement is between Quality Engineering Associates, Inc. (“QEA”), and the 

customer who has procured the licensed software for use as an end user (“Customer”). 

QEA provides FlexoIAS-IIPC Flexographic Plate Measurement System control software 

in object code, including documentation, updates, revisions and other related material 

(collectively referred to as the “Software”) under the following terms and conditions. 

Please read the terms and conditions of this License carefully. BY OPENING THE 

SOFTWARE PACKAGE OR USING THE SOFTWARE DELIVERED WITH THIS 

AGREEMENT YOU INDICATE YOUR AGREEMENT WITH THE TERMS AND 

CONDITIONS OF THIS LICENSE. 

 

1. License. QEA hereby grants to the Customer and the Customer hereby accepts a 

personal, non-exclusive, non-transferable license to use the Software solely for 

Customer's internal use on a number of computers equal to the number of licenses 

purchased, as set forth on QEA’s invoice. The Customer may not assign, sub-license or 

transfer the Software to any third party without the prior written consent of QEA except 

that the Software may be transferred as part of the FlexoIAS-IIPC Flexographic Plate 

Measurement System (“System”), provided that the Customer does not retain any copies 

of the Software and the recipient of the System agrees in writing to the terms of this 

license. 

 

2. Term. The term of this License shall commence upon shipment of the Software to 

the Customer and continue until terminated. This License shall terminate automatically if 

the Customer is more than thirty (30) days in default of payment in full, or sells, disposes 

of, or otherwise ceases to possess the Software or transfers the Software other than with 

the prior written agreement of QEA or as otherwise provided herein. 

 

3. Permitted Uses and Copies. The Software, excluding Documentation, may be 

copied only for archival and back-up purposes and such copies must include QEA’s 

copyright and proprietary right notices on the Software. Documentation may not be 

copied. The Customer is licensed to read the diskette(s) from the medium into the 

memory of a computer solely for purposes of executing the Software. Installation on a 

network server for the sole purpose of distribution to one or more other computer(s) shall 

not constitute “use,” however the access to the Software on such server by individual 

computers shall constitute “use” for which a license is required. The Software shall not 

be rented, leased, sold, translated, modified, altered, adapted, used to create derivative 

works, reverse compiled, disassembled or otherwise reverse engineered. 

 

4. Warranty. QEA warrants that the Software will conform to QEA’s prevailing 

published specifications in effect on the date of delivery. The Customer must notify QEA 

in writing of any defect within the warranty period for such Software licensed as listed on 

the quotation or invoice (“Warranty Period”). The warranty services described herein are 

contingent upon the proper use of the Software and do not cover Software which has 

been modified without QEA’s written approval or which has been subjected to unusual 

physical or electrical stress. 
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 EXCEPT FOR THE WARRANTIES SET FORTH IN THIS SECTION QEA 

DISCLAIMS ALL WARRANTIES EXPRESS OR IMPLIED, INCLUDING BUT NOT 

LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 

FITNESS FOR A PARTICULAR PURPOSE. QEA DOES NOT WARRANT THAT 

THE OPERATION OF THE SOFTWARE IS INTERRUPTION OR ERROR FREE. 

 

5. Remedies and Limitation of Liability. The Customer’s exclusive remedy and 

QEA’s entire liability for breach of warranty for Software supplied under this License 

shall be for QEA to use reasonable efforts to remedy any failure of the Software to 

conform to such specifications when such failure is reported to QEA within the Warranty 

Period, or at QEA’s option, refund the purchase price. 

 

 IN NO EVENT SHALL QEA BE LIABLE TO THE CUSTOMER FOR 

SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR ANY 

DAMAGES ARISING FROM THE LOSS OF USE, DATA, OR PROFITS. QEA 

SHALL NOT BE LIABLE FOR DAMAGES FROM ANY DEFECT IN SOFTWARE, 

CLAIMS BY THIRD PARTIES OR ANY OTHER CLAIM, WHETHER IN TORT, 

CONTRACT, NEGLIGENCE, OR OTHERWISE ARISING MORE THAN ONE (1) 

YEAR PRIOR TO INSTITUTION OF A LEGAL PROCEEDING THEREON. 

 

6. General. This License shall be governed by and construed in accordance with the 

laws of the Commonwealth of Massachusetts, and every state district court or United 

States district court in the Commonwealth of Massachusetts shall be competent courts of 

jurisdiction. 

 

7. Customer Acceptance. The Customer acknowledges that it has read this License, 

understands and accepts it, and agrees to be bound by its terms and conditions. 
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LIMITED HARDWARE WARRANTY 

 

 

Warranty. QEA warrants all Products sold to be free from defects in materials and 

workmanship and to conform to QEA's published specifications for the Warranty Period 

stated in the Quotation. QEA does not warrant peripheral products not purchased from 

QEA, but used in conjunction with the Products. Results of ordinary wear and tear, 

improper operation or maintenance, operating without a power surge protector, or use of 

corrosive or abrasive materials shall not be considered a defect in material or 

workmanship. Liability under this warranty shall be limited to the repair or replacement 

at QEA's plant of any defective Product, the choice between repair and replacement being 

at QEA's option. If Purchaser encounters a suspected defect or non-conformity in the 

Product, Purchaser shall so notify QEA, which may request return of the Product (with 

return shipping at Purchaser's expense) to QEA's plant for inspection. Any returns must 

be accompanied by a return material authorization number issued by QEA. Upon the 

repair or replacement of a defective part, QEA's warranty shall continue for the repaired 

or replaced part for the remainder of the Warranty Period for the original part, except that 

no repaired or replaced part shall carry a warranty of less than 30 days. Consumables 

such as light bulbs and test targets on paper are excluded from QEA warranty.  

 

Other exclusions from this warranty include any loss, damage and/or instrument 

malfunction resulting from: 

 Shipping 

 Faulty storage or maintenance 

 Accident, breakage, abuse, alteration, contamination or misuse 

 Inadequate or unstable utility service or power 

 

Any disassembly of the Product or its components, or replacement of original 

components by the Purchaser will render the warranty void, unless explicit instructions 

for disassembly are given by QEA. 

 

For items, such as PCs, monitors and scanners, which may be supplied by QEA but are 

not manufactured by QEA, the warranty of the manufacturer will be transferred to the 

Purchaser. 

 

The replacement cost for any lost software security key is the cost of one license. 

 

Limitation of Liability. THE WARRANTY DESCRIBED ABOVE IS IN LIEU OF 

AND EXCLUDES ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR 

STATUTORY, INCLUDING BUT NOT LIMITED TO, THE WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
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System Overview 
 
FlexoIAS-II brings to the shop floor a sophisticated tool previously available only in the 

laboratory.  The simplicity of making FlexoIAS-II measurements means that objective 

plate quality assessment can now be done quickly, easily and reliably.  This lowers costs 

by catching errors earlier in the workflow, reducing down-time and waste.  

 

 
 

Fig. 1 FlexoIAS-II Flexographic Plate Measurement System 

 

The FlexoIAS-II system consists of hardware, control and analysis software and 

documentation as follows: 

 

1) Hardware: 

a. Measurement unit and special transmission light box (Figs. 1 above and 2a 

and 2b below) 

b. Transmission Reference Standard (Fig. 7 below) 

 

2) Software and PC Requirements: 

a. IASLab
™

 control software for interactive analysis of flexo plates 

b. PC Requirements for running the control software:  

 customer-supplied PC with Windows XP or Windows 7 

 USB2.0 interface for the Measurement unit 

 Microsoft Access database (for systems with process control option) 

 Excel is recommended but optional 

 

3) Documentation: 

a. Quick Start Guide 

Measurement Unit 

Light Box 

Control Strip 
(Test Sample) 

Sample Guide 
(Optional) 

User-supplied PC with XP 
or Windows 7 and USB2.0  
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b. User’s Guide  

 

  
Fig. 2a. FlexoIAS-II Measurement Unit 

and Light Box with test sample 

 

Fig. 2b. Alignment Template for 

Measurement Unit 

  
Fig. 3a FlexoIAS-II with optional Guide 

for Control Strip and Measurement 

Unit 

Fig. 3b. Optional Guide for Control Strip 

and Measurement Unit 
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The FlexoIAS-II Family of Systems 
 

The FlexoIAS-II families of systems are QEA instruments designed for flexographic 

plate and print quality analysis. They include the FlexoIAS-II, FlexoIAS-IIP, FlexoIAS-

IIPC, FlexoIAS-IIPCP and FlexoIAS-IIPC2P. For details on standard operation of your 

specific FlexoIAS-II system, refer to Appendices C and D, Engineer’s Standard 

Operating Procedure and Operator’s Standard Operating Procedure, respectively. 

 

The FlexoIAS-II and FlexoIAS-IIPC are used exclusively for analyzing flexo plates, 

while the FlexoIAS-IIP and FlexoIAS-IIPCP also have print measurement capabilities. 

 

The FlexoIAS-II and FlexoIAS-IIP2 are designed for interactive analysis only (Figure 

4a). In interactive mode, the operator selects a region of interest (ROI) and clicks one of 

the analysis icons on the tool bar. The analysis results are displayed almost 

instantaneously. Results are often exported to other applications, such as Excel, for 

further analysis and reporting. 

 

The FlexoIAS-IIPC and FlexoIAS-IIPCP include a Process Control mode in which the 

user defines measurement sequences for automated processing. In process control mode, 

the operator is guided through the analysis sequentially and the measurement results are 

logged into a Microsoft Access database along with all the relevant details, such as date 

and time of test, plate supplier, plate type and operator, information critical for process 

control and quality management applications.   

 

 
Analysis Functions 

 

FlexoIAS-II systems are designed for ease of use.  Sophisticated algorithms are built in to 

enable “one-click” analysis of dot and halftone attributes throughout most of the tonal 

range. One click of the FlexoDot tool shown in Fig. 5, and the analysis is done. For 

 
Fig. 4a Interactive Tools (FlexoIAS-II and 

FlexoIAS-IIP) 

 

 
Fig. 4b  Process Control (Programmed  

Sequence Measurement) Tools (FlexoIAS-IIPC 

and FlexoIAS-IIPCP only) 
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highlight dots, the HiliteDot tool includes a spatial filter to analyze even difficult digital 

plates containing small dots, as shown in Fig. 6. 

 

With the FlexoIAS-II, a user can easily obtain Dot% and Line Screen (lpi or lpcm) to 

assess flexo plate quality. Other quality attributes such as dot size (diameter and area), 

box ratio (aspect ratio), perimeter, circularity (edge roughness), screen angle, and dot 

locations can also be analyzed. 

 

 

Fig. 5  FlexoDot Tool for analysis throughout most of the tonal range 

 

 

Fig. 6. HiliteDot Tool for measurement of very small dots. 
 

 

 

FlexoDot Tool 

HiliteDot Tool 
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Calibration 

 

A special Transmission Reference Standard, shown in Fig. 7 below, and an automated 

calibration procedure included with the FlexoIAS-II system enable consistent, repeatable 

measurements, independent of plate type, thickness or color.  

 

 
Fig. 7  Transmission Reference Standard for system 

calibration and performance verification 
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The Measurement Unit 

The FlexoIAS-II system has three main components, as shown in Figs. 8 and 9 below:  

 a high performance digital camera module 

 a high-resolution optics module 

 an external light box for transmissive measurements of flexographic plates 

The camera module fits together with the optics module to form the FlexoIAS-II 

measurement unit. 

 

Figure 8:  Camera and high resolution optics modules 

 

There are two buttons on the FlexoIAS-II camera module. When the software is running, 

the button on the left side (visible above) of the module activates and deactivates camera 

preview mode. When the camera is in preview mode, the image pane of the user interface 

shows a live video image. When preview mode is turned off, the interface shows a static 

“snapshot”. Preview mode can also be toggled on and off by clicking the preview  

icon at the upper left of the screen.  

The button on the right side of the module (not visible above) is not used for interactive 

measurements on FlexoIAS-II systems. 

 

Measurement 

Button 

Camera Module 

High Resolution 

Optics Module 

This side towards 

the operator 

This side away 

from the operator 
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Connecting the Measurement Unit to your PC 

 The FlexoIAS-II software must be installed on your PC before you plug the 

measurement unit into the PC for the first time. Follow the instructions in the 

Quick Start Guide provided with the system for complete software installation 

instructions. 

 Plug the measurement unit into an available USB 2.0 port on your PC.  The first 

time you do this, follow the step-by-step Quick Start Guide instructions for 

installing the measurement unit device drivers. Be sure to give the PC sufficient 

time to detect the devices. If at another time you plug the measurement unit into a 

different USB 2.0 port, you may be prompted to reinstall the device drivers. Do so 

by following the same step-by-step installation procedure. 

 Start the FlexoIAS-II software. Dismiss the About window and wait for the 

software to initialize. When the software is ready, three analysis icons—

FlexoDot, HiliteDot, and Area—will appear in a vertical array at the left side of 

the image pane. 

 

Caring for the FlexoIAS-II 

 The FlexoIAS-II is an optical instrument. Dust and dirt on the optics or light 

source will affect the accuracy and reproducibility of measurements. Therefore, it 

is advisable to use and store the FlexoIAS-II in a clean environment or at least to 

maintain the cleanliness of all optical surfaces and the illumination source. 

 Do not touch the surface of the lens or CCD with your fingers. 

 Remove any dust on the lens or CCD with clean, dry compressed air. 

Important: Never attempt to remove dust by blowing on the optics! 

 Remove fingerprints and dust from the optical window with clean, dry 

compressed air or by wiping it with the cleaning cloth provided. 

Important: Never use solvents to clean any part of the FlexoIAS-II! 

 Keep the measurement unit in its carrying case when not in use. 
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The Light Box 

The light box houses a high intensity white LED light source and optics that provide a 

consistent, collimated light source for transmissive flexo plate measurements. The light is 

transmitted through an optical window in the center of the box. 

 

On top of the light box is a vinyl sticker in the shape of the FlexoIAS-II footprint, as 

shown in Figure 7 above.  This is an aid for easy alignment of the measurement unit with 

the light window. 

 

When a calibration is performed, the exposure (shutter) in the FlexoIAS-II measurement 

unit is set in conjunction with the light box and the Transmission Reference Standard. All 

components—measurement unit, light box, and Transmission Reference Standard—are 

serialized. Mixing components from different systems identified by different serial 

numbers is not recommended. 

 

The light box and measurement unit, with and without the Optional Control Strip Guide, 

are shown in Figs. 9 and 10, respectively. 

 

 
Fig. 9.  FlexoIAS-IIPC with optional control strip guide. 
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Fig. 10.  FlexoIAS-II without optional control strip guide. 
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The Software 

 

Before you start the FlexoIAS-II software, be sure the measurement unit is plugged into a 

USB2.0 port in your PC. After plugging it in, wait for about 10-15 seconds to give the PC 

time to recognize the hardware before launching the software. Typically, you will hear 

three sounds indicating that the device drivers are loaded.   

 

Note that if the measurement unit is plugged into a different USB2.0 port at a later time, 

you may be prompted to install the device drivers again. Follow the driver installation 

instructions detailed in the Quick Start Guide. 

 

When the measurement unit is installed and functioning properly, an About FlexoIAS-II 

start-up box will appear: 

 

 
Fig. 11.  The About box appears on start-up of the FlexoIAS-II software. 

 

Click OK to dismiss the About box. The main user interface will be displayed after a 

brief pause while the software initializes. 
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Fig. 12  The FlexoIAS-II User Interface and Nomenclature (non-Process Control 

software). 

 

NOTE: In actual practice, the contents of the Menu bar will vary depending on 

the software package.  

For systems without the process control option (FlexoIAS-IIor FlexoIAS-IIP), the 

menu bar will look as shown in Fig 12 

For systems with the process control option (FlexoIAS-IIPC, FlexoIAS-IIPCP and 

FlexoIAS-IIPC2P), the menu bar will only contain four buttons; the right arrow 

, which activates or deactivates a live preview of the image to be analyzed, 

Load Settings, Verify and Process Control. 

 

The default mode of the software is “interactive”. In this mode, the user controls 

every step of the measurement process, placing ROIs and, for some analyses, sub-

ROIs on the image in the image pane and running the desired tests by clicking the 

appropriate analysis icons on the toolbar at the left. Results are displayed in the 

results pane.  

Titlebar 

Menu bar 

Command 

  Toolbar 

Analysis 

 Toolbar 

Status bar 
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In process control mode, an operator runs automated tests by using the Load 

Settings, Verify and Process Control buttons only. 

 

In order to use the system in process control mode, however, an automated test 

sequence must first be created by following the procedure described in Appendix 

A. 

While in sequence design mode, the user interface looks like this: 

 

 

 

As you can see, the analysis toolbar at the left and the process control buttons at 

the top have disappeared, and an array of command icons has appeared on a 

command toolbar above the image pane. These are the commands used in creating 

an automated test sequence in sequence design mode. The command icons remain 

visible until the user switches out of Sequence Design View. At that point, the 

system is ready either for more interactive tests or for operation in process control 

mode. 
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Making Measurements 

To get a feel for making measurements, start by placing a plate sample on top of the light 

box.  Then place the measurement unit on top of the plate. as shown in Fig. 10 above. 

Click the Preview button  at the top left of the user interface to display a live image of 

the sample in the image pane, as shown in Fig. 13 below. 

 

 
Fig. 13. FlexoIAS-II in preview mode. 

 

Verify that the software is in preview mode by moving the sample slightly under the 

measurement unit. In preview mode, you should see the image move when you move the 

sample. If all steps described thus far have been carried out successfully, your system is 

ready to make measurements. 

 

Interactive Mode 

 

The FlexoIAS-II operates in either interactive or process control mode, depending on 

application requirements at a given time. Let’s first acquaint ourselves with interactive 

mode, in which the user controls every step in the analysis of each sample. 

 

Interactive Mode: FlexoDot Tool 

 

Place a sample on the light box and position the measurement unit over the tone patch to 

be analyzed. Click on the FlexoDot icon. A FlexoDot analysis will be performed, 

typically on a region of interest occupying the center 70 percent of the field of view. The 

Dot % and Line Screen for this tone patch are shown in the results pane, as in the figure 

below: 
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Fig. 14. Interactive analysis using the FlexoDot Tool. 

 

Note that: 

1. Real-world analyses of halftone patterns produce more results in the results pane, 

including dot diameter, dot shape, dot location, screen angle, etc., than are shown 

here. For the sake of simplicity, the results displayed in Fig. 14 are limited to Dot% 

and Line Screen for day-to-day process control applications. How to show 

additional analysis results will be described in the Software Reference Guide later 

in this User’s Guide. 

2. Line Screen units can be specified as lpcm (lines per cm) or lpi (lines per in). This 

is described in the Software Reference Guide below. 

 

Interactive Mode: HiliteDot Tool 

 

Position the FlexoIAS-II over an area of hilite dots, and click on the HiliteDot tool to 

analyze the dots. (Note that hilite dots can be used as a filtering device when halftone 

dots are on a “noisy” background.) Fig. 15 shows the results of a highlight dot analysis. 

The HiliteDot tool will be described in detail in the Software Reference Guide below. 

 

FlexoDot Tool 
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Fig. 15.  Interactive analysis using the Hilite Dot Tool. 

 

Interactive Mode: Area Tool 

 

Finally, position the FlexoIAS-II on a solid patch, and click on the Area tool to measure 

the %Transmission of the patch (e.g., a 100% patch or a transmission reference target 

area). The results of a typical measurement are shown in Fig. 16 below. 

 

The interactive measurements appear to be effortless, because the work is done by the 

software, and the “intelligence” is built into the analytical algorithms and default test 

parameters specified in the Options menu. For many applications, the default parameters 

will work well. However, on occasion, the test parameters may need to be changed to 

ensure appropriate analyses. Refer to the Software Reference Guide below for details on 

setting test parameters. 

 

 

HiliteDot Tool 
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Fig. 16 Interactive Area tool analysis (for transmission measurement) 

 

 

  

Area Tool 
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Software Reference Guide 

For instructions on how to configure the software, refer to the Quick Start 

Guide provided with your FlexoIAS-II. 

 

Note that the software must be installed before the measurement head is 

plugged in. The measurement head must be plugged in and functioning for 

the software to work. 

 

Performing an analysis with the FlexoIAS-II takes just a few simple steps. First, specify a 

region of interest on the test sample or on a saved image you want to analyze. Then select 

the appropriate tool on the analysis toolbar to perform the test. The field of view will 

appear in the image pane, and the analysis results will appear in the results pane on the 

monitor. For a detailed look at the data, use the Record commands from the View menu 

or click on a particular feature of interest in the image pane to view detail data in the 

results pane.  

 

In this section, a detailed description is given of each menu, command and dialog box.  

The topics are organized in menu order from left to right, as follows: 

 

 File menu 

 Edit menu 

 View menu 

 Options menu 

 Tools menu 

 Setup menu 

 Help menu 
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File Menu 

 

 

The File menu commands are described below. 

Open Command  

Use the File | Open command (shortcut CTRL+O) to select an existing image file. A 

standard Windows dialog box will open. 

 

Save Command  

Use the File | Save command (shortcut CTRL+S) to save the active image using its 

existing file name. To change the file name or directory before saving, use the File | Save 

As command below. 

 

Save As Command  

Use the File | Save As command to save the active image file under a new name. To save 

a document using its existing name and directory, use the Save command above. 

 

Save Image With Overlays Command  

When the FlexoIAS-II performs an analysis, graphical overlays are created. Depending 

on which overlay options are selected, these may represent the ROI and image features 

such as the contour edges of dots. Use the File | Save Image With Overlays command to 

save the image with any selected overlays. Use the View | Overlays command below to 

display or hide overlays. 

 

Note that the overlays are destructive to the bitmap. After using the Save Image With 

Overlays command you will not be able to use the image for further analysis. 
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Save Results Command  

Use the File | Save Results command to save the results pane data to a text file. Save 

Results displays a standard Windows Save As... dialog box. 

 

Save All Detail Records Command  

Use the File | Save All Detail Records command to name and save the results for each 

element in the currently displayed analysis to a text file. Save All Detail Records displays 

a standard Windows Save As... dialog box. 

 

Properties Command 

Depending on the source of an image, the resolution parameters may need to be adjusted. 

Use the File | Properties command to display image dimensions and spatial resolution. If 

necessary, use the File | Properties dialog box to set the image resolution. 

 

Default Directories Command 

Use the File | Default Directories command to specify default directories to save image 

files to. These files contain images saved with the File | Save As or File | Save Image 

With Overlays commands. 

 

Note that the other directories shown in the Default Directories dialog box are not 

typically used. However, for specialized configurations these directories allow users to 

define locations for the specified file types.  

Data Logging Command 

Use the File | Data Logging command to automatically log analysis results to a text file. 

The procedure described in the Making Measurements section above is ideal when small 

amounts of data are being acquired. However, with large amounts of data, efficiency 

becomes a key consideration. The Data Logging feature is designed to make data 

collection and management as efficient as possible. 

When logging is enabled, the results of each analysis are written to a text file for later 

analysis.  

To enable data logging, do the following. 

Create a Log File: 

 Select File | Data Logging 
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 Click the Browse button to the right of Summary Record Log File and / or 

Detail Record Log File. Both may be selected. 

 Navigate to the directory you want your data saved to.  

 Enter a file name for your data.  

 Check Log all summary records and / or Log all detail records. 

 Click OK. 

 When either of the summary or detail data logging option is selected, the 

Logging Disabled message on the Status bar at the bottom of the FlexoIAS-II 

screen will change to Logging Active (N=0). 

 The Measurement Database field specifies what database the results will be 

written to.  

Note that the Measurement Database field is used only with the Process 

Control (FlexoIAS-IIPC and FlexoIAS-IIPCP) configurations of FlexoIAS-II. 

 

Set the measurement parameters 

Follow the instructions in Making Measurements above to:  

 Capture an image 

 Specify the ROI 

 Set analysis tools parameters as needed 

 

Make your measurements: 

 Click the orange button on the measurement head to run the analysis. 

 Click the button again to return to preview mode. 
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 Reposition the sample and measurement head to analyze a new region of 

interest. 

 Press the orange button again to repeat the analysis on the new ROI. 

After each measurement, the number after Logging Active on the Status bar 

will be incremented by one. 

 

Close the Log file 

After you have completed your measurements: 

 Select File | Data Logging 

 Uncheck the box next to Log all summary records and/or Log all detail 

records 

 Click OK 

The indicator on the Status bar will change back to Logging Disabled 

 

Preview Command  

Use the File | Preview command to toggle between live and captured images. This 

command corresponds to using the orange button on the measurement head. 

 

Density/Color Setup Command (Calibration Settings) 

 
 

Use the File | Density/Color Setup command to specify the Illuminant and Observer for 

CIE color measurements and the Density Standard to use for density measurements.  

Normally the images in FlexoIAS-II are monochrome and these advanced calibration 

settings are not used. 
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Print Command  

Use the File | Print command (shortcut CTRL+P) to print the current image. The current 

ROI and magnification will be printed, so you may need to adjust these prior to printing. 

If an analysis has been performed, any visible overlays will also be printed. 

The Print command opens a standard Print dialog box in which you can select the range 

of pages to be printed, the number of copies, the destination printer, and other printer 

setup options.  

 

Print Table Command  

Use the File | Print Table command (shortcut CTRL+P) to print the data currently 

displayed in the results pane. Prior to printing, adjust the widths of the columns as 

desired. 

The Print Table command opens a standard Print dialog box in which you can select the 

range of pages to be printed, the number of copies, the destination printer, and other 

printer setup options. 

 

Print Setup Command  

The File | Print Setup command opens a standard Print Setup dialog box that allows you 

to specify printer options. 

 

Exit Command  

Use the File | Exit command (shortcut ALT+F4) to exit the FlexoIAS-II software.  
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Edit Menu 

 
 

Edit menu commands are described below. 

Copy Command  

Use the Edit | Copy command (shortcut CTRL+C) to copy the selected image or region 

of interest onto the clipboard. If no data are selected, this command is unavailable. To 

select the entire image, use the Edit | Select All command below, then select Copy to 

place the image on the clipboard. 

Note that copying data to the clipboard replaces the previous clipboard contents. 

 

Copy Table Command  

Use the Edit | Copy Table command to copy the data currently displayed in the results 

pane to the clipboard. 

Copying data to the clipboard replaces the previous clipboard contents. 

 

Select All Command  

Use the Edit | Select All command (shortcut CTRL+A) followed by the Copy command. 

The ROI expands to encompass the entire image. 

 

70% ROI Command  

Use the Edit | 70% ROI command to include the center 70 percent of the image in the 

ROI. 
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Define ROI Command  

Use the Edit | Define ROI command to set the ROI to user-controlled dimensions. 

 

Reset Sub-ROIs 

Use the Edit | Reset Sub-ROIs command to set the sub-ROIs to the size and relative 

positions in the center of the field of view for an amplitude modulated (AM) dot pattern 

of known screen ruling. 

 

Flip Horizontal Command  

Use the File | Flip Horizontal command to flip the current image horizontally, reversing 

the left and right edges. 

 

Flip Vertical Command  

Use the File | Flip Vertical command to flip the current image vertically, inverting the top 

and bottom edges. 

 

Rotate 90° CW  

Use the File | Rotate 90° CW command to rotate the current image 90º clockwise. 

 

Rotate 90° CCW  

Use the File | Rotate 90° CCW to rotate the current image 90º counterclockwise. 

 

Rotate 180°   

Use the File | Rotate 180° to rotate the current image 180º. 
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View Menu 

 
 

The View menu commands are described below. 

Sequence Design View  

Sequence Design View is available if your software includes the sequence programming 

feature. Sequence programming is included on configurations with the process control 

option. If your system is the basic FlexoIAS-II, sequence programming is not included. 

Use the View | Sequence Design View command to toggle between the normal mode for 

user-controlled measurements and sequence design mode for creating automated 

measurement sequences.  

For details on sequence programming, see Appendix A, Sequence Programming Guide. 

Toolbar Command  

Use the View | Toolbar command (shortcut ALT+V+T) to hide or display the analysis 

toolbar. The toolbar contains analysis tools for performing interactive measurements of 

dots and other image elements. 

 

The analysis toolbar is typically displayed vertically at the left-hand side of the 

FlexoIAS-II window. It provides quick access to all the FlexoIAS-II tools and their 

settings options.  
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To use any tool in the toolbar, first specify a region of interest on the image in the image 

pane and then select the desired measurement tool. 

 

Tool        Function 

 Performs a dot analysis on a flexographic plate 

 Performs a highlight dot analysis 

 Performs an area analysis 

 

Note that you can right-click on any tool icon for quick access to the corresponding 

Options dialog box. 

 

Status Bar Command 

Use the View | Status Bar command to display or hide the Status Bar at the bottom of the 

screen. The status bar (shown below) indicates whether data logging is enabled or 

disabled, and provides image information such as the X and Y coordinates of the cursor 

and the color coordinates of the pixel at the cursor location (e.g., red, green and blue 

values on a 0-100% scale).  

Color coordinates can be displayed in any of several color spaces by selecting from the 

View | Color Space command (see below). 

 

 
 

The Status Bar above shows which of the following options are in use: 

CAP Caps Lock key (not in use) 

NUM Number Lock key (in use) 

SCRL Scroll Lock key (not in use) 

Data Logging Logging disabled indicator (Data Logging is not in use)  

 

Split Command 

Use the View | Split command to move the vertical split separating the image and results 

panes. This command is especially useful if the split has migrated off the screen or 

otherwise becomes difficult to locate. 

 

Image Pane Only  

Use the View | Image Pane Only command to move the vertical split to the far right, 

maximizing the image pane and hiding the results pane. 
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Results Pane Only  

Use the View | Results Pane Only command to move the vertical split to the far left, 

maximizing the results pane and hiding the image pane. 
 

Restore Split Command 

Use the View | Restore Split command to restore the vertical split to its previous position 

(i.e., its position prior to invoking the Image Pane Only or Results Pane Only command). 

 

Results Display Command 

Use the View | Results Display command to specify which fields are to be shown in the 

results pane for the specified analysis. Use the navigation arrows and buttons to move 

fields between the Available Fields and Selected Fields lists and to change Selected Field 

order. 

 

 
 

Select Font Command 

Use the View | Select Font command to specify the font to be used in the results pane. 

 



FlexoIAS™-II Flexographic Plate Measurement System 

© Quality Engineering Associates, Inc. 36 

Channels Command 

In FlexoIAS-II analyses, images are normally monochrome and the View | Channels 

command is not used. 

Overlays Command 

Use the View | Overlays command to display or hide graphical overlays. 

 

 

Overlays Options: 

Set All. Turns on all overlays. 

Clear All. Turns off all overlays. 

ROIs. Hides or shows ROI boxes. 

Sub-ROIs. Hides or shows sub-ROI boxes. Note that sub-ROIs are used only for 

certain applications and can generally be ignored. 

Bounding Boxes. Hides or shows bounding boxes for analyzed elements (dots, solid 

areas, etc.). 

Center Marks. Hides or shows center marks for analyzed elements. 

Outlines. Hides or shows contour outlines for analyzed elements. 

Scale. Hides or shows a scale (displayed in mm or µm depending on magnification 

and ROI size) at the bottom of the image pane. 
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The following images show the effects of selecting the various overlay options, any 

combination of which can be selected. 

 

Options selected: 

 
             ROI               …plus Bounding Box      …plus Center Marks            …plus Outlines 

 
 

Zoom Command 

Use the View | Zoom command to increase or decrease the magnification of the image.  

In software packages that include process control, the zoom commands are accessible 

from the view menu only. If your system does not include process control, the zoom 

options are accessible from both the command toolbar and View menu. 
 

Zoom option Toolbar 

icon 

                      Function 

Zoom In  Increases magnification 

Zoom Out  Decreases magnification 

Actual Size  Sets the magnification so each pixel in the 

image corresponds to one pixel in the 

display. This setting generally avoids 

artifacts in the image display. 
Scale to Fit 

 
Sets the magnification so the entire image is 

displayed in the image pane. 
Scale to 

ROI  
Sets the magnification (and scroll) so the 

contents of the current ROI are displayed in 

the image pane. 

 

Dimension Mode Command 

Use the View | Dimension Mode command to make manual measurements of image 

features. Left-click to position one marker and right-click to position a second marker. 

The distance and angle between the two markers appear in the results pane. 



FlexoIAS™-II Flexographic Plate Measurement System 

© Quality Engineering Associates, Inc. 38 

 

Record Command 

In software packages that include process control, the record commands are only 

accessible from the View menu. In packages that do not include process control, the 

record commands are accessible from both the Command toolbar and the View menu. 

Use the View | Record command to navigate through the features in the ROI and specify 

whether detail or summary data will appear in the results pane (individual dot diameters 

vs. average dot diameter, for example). Note that details can be tracked visually in the 

image pane when outline overlays are selected. 

 

Option Toolbar 

icon 

               Function 

Summary  Displays the summary data for all image 

elements analyzed (e.g., all dots within the 

ROI). 

In Sequence Design View, this is the 

summary of the current sequence; 

otherwise, following an interactive analysis 

or a step of a sequence, this is the summary 

result for the analysis tool. 

Previous 

Detail 
 Navigates to the previous detail element 

(e.g., an individual dot) and displays results 

for that detail only. 

In Sequence Design View, this is the 

previous sequence step; otherwise, 

following an interactive analysis or a step of 

a sequence, this is the detail record for an 

individual object analyzed. Following a 

sequence, this is the summary record for an 

individual step in a sequence. 

Next 

Detail 
 Navigates to the next detail element and 

displays results for that detail only. 

In Sequence Design View, this is the 

previous sequence step; otherwise, 

following an interactive analysis or a step of 

a sequence, this is the detail record for an 

individual object analyzed. Following a 

sequence, this is the summary record for an 

individual step in a sequence. 
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Graph Command 

Use the View | Graph command to display graphical data from the most recent analysis, 

if graphing is a feature of the tool used for that analysis.  
 

Profile Command 

Use the View | Profile command to display the reflectance profile for the selected ROI. 
 

Histogram Command 

Use the View | Histogram command to display the histogram for the selected ROI. 
 

Color Space Command 

Use the View | Color Space command to specify which color space to use for displaying 

color coordinates in the status bar. 
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Options Menu 

 
 

The Options menu commands are described below. 

Note that the Options menu is not available when the software is in sequence design 

mode. 

Add/Remove Tools Command 

Use the View | Add/Remove Tools command to activate or remove tool libraries. 

Activating a library inserts the tools in that library into the Options and Tools menus and 

places them on the analysis toolbar. 

Current Tool Libraries. Lists the tool libraries currently installed. 

Add. Opens a File | Open dialog box in which you can browse to select the DLL file 

containing the tool library you want to add. The DLL must be in the same folder 

as the main executable.  

Remove. Removes the selected tool library from the Current Tool Libraries list. The 

tools in the selected library will be removed when the software is restarted. 

Activate Now. Allows you to activate a new library. Note that an activation code 

provided by QEA is required to activate all new libraries. 

Activate Automation. Allows you to activate the license for an optional component 

that provides an automation interface to FlexoIAS-II. The automation interface 

allows external control over some FlexoIAS-II features using Visual Basic for 

Applications or other programming languages. For more information, contact 

QEA. 

Tools In Library. Lists the analysis tools contained in the selected library. 

 

Options for the FlexIAS-II analysis tools—FlexoDot, HiliteDot, and Area—are detailed 

in the next section, Tools Menu. 
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Tools Menu  

The Tools menu contains tools for performing dot, highlight dot, and area analyses, as 

described below. 

 

FlexoDot Tool 

 The FlexoDot tool is used for analyzing dots on a flexographic plate. To access 

the FlexoDot tool, select Tools | FlexoDot or click the FlexoDot tool on the analysis 

toolbar.  

To change FlexoDot tool input parameters, right-click on the FlexoDot tool icon or select 

FlexoDot from the Options menu. 

The FlexoDot tool reports the following metrics: 

Area (mm²/µm²): The area of the dot. 

Diameter (mm/µm): The equivalent circular diameter of the dot, given by: 

A
D

4
, where A = area 

Perimeter (mm/µm): The length of the outside boundary of the dot. 

BoxRatio: The height-to-width ratio of the bounding box of the dot. 

Circularity: The circularity of the dot. The degree of circularity is given by:  

)4(2 ApC , where p = the perimeter length and A = area 

 Note that a circularity of 1 denotes a perfectly circular dot. Dots of any other 

shape will have a circularity greater than 1. For very small dots, the circularity 

measurement may be inaccurate, giving a value of less than 1. 

XCentroid (mm/µm): The horizontal coordinate of the dot centroid. 

YCentroid (mm/µm): The vertical coordinate of the dot centroid. 

XMidpoint (mm/µm): The coordinate of the horizontal center of the dot’s bounding 

box. 

YMidpoint (mm/µm): The coordinate of the vertical center of the dot’s bounding 

box. 
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BoundLeft (mm/µm): The left coordinate of the dot’s bounding box. 

BoundTop (mm/µm): The top coordinate of the dot’s bounding box. 

BoundRight (mm/µm): The right coordinate of the dot’s bounding box. 

BoundBottom (mm/µm): The bottom coordinate of the dot’s bounding box. 

BoundWidth (mm/µm): The width of the dot’s bounding box. 

BoundHeight (mm/µm): The height of the dot’s bounding box. 

RMS Roughness (mm/µm): The roughness of the contour using an RMS calculation 

and the specified high pass filter cutoff. 

Red (%): The average reflectance of the dot in the red channel of the image. 

Green (%): The average reflectance of the dot in the green channel of the image. 

Blue (%): The average reflectance of the dot in the blue channel of the image. 

Spacing (mm/µm): The average spacing in an AM (amplitude modulated) dot 

pattern. 

Ruling (lpcm): The number of lines per centimeter in an AM (amplitude modulated) 

dot pattern. 

Ruling (lpi): The number of lines per inch in an AM (amplitude modulated) dot 

pattern. 

Screen Angle (deg): The screen angle in an AM (amplitude modulated) dot pattern. 

Dot Percent (%): The dot percent in an AM (amplitude modulated) dot pattern. If 

the dots are darker than the field, it is assumed that they occupy an unprinted area, 

so small dark dots correspond to a large dot percent value. If the dots are lighter 

than the field, it is assumed that they occupy a printed area, so small light dots 

correspond to a small dot percent value. 
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FlexoDot Settings 

 
 

FlexoDot settings are as follows: 

Color: Specifies which Color Plane to use for dot analysis. 

Threshold Type: Specifies Absolute or Relative thresholding. Relative threshold 

values are relative to the content of the ROI. 

Polarity: Specifies whether the dots are darker or lighter than their background. 

Units: Specifies the units (mm or µm) to use for reporting length and area values. 

Threshold: Specifies the threshold to use for locating dot edge boundaries. 

Filter Dots By Diameter: Turns on the dot size filter, specifying minimum and 

maximum diameters. Dots of diameters outside this range will not be reported. 

Filter Dots by Box Ratio: Turns the box ratio filter on, specifying minimum and 

maximum box ratios. Dots with box ratios outside this range will not be 

reported. 

Filter Dots By Circularity: Turns the circularity filter on, specifying minimum 

and maximum circularities. Dots of circularities outside this range will not be 

reported. 
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Auto Size: Turns on automatic size filtering. To use automatic size filtering, 

select both Auto Size and Filter Dots by Diameter. The Diameter Minimum 

and Diameter Maximum values are ignored when Auto Size is selected. 

Diameter Minimum: Specifies minimum dot diameter. Dots of smaller diameter 

will not be reported. 

Diameter Maximum: Specifies maximum dot diameter. Dots of larger diameter 

will not be reported. 

Box Ratio Minimum: Specifies minimum box ratio. Dots with smaller box ratios 

will not be reported. 

Box Ratio Maximum: Specifies maximum box ratio. Dots with larger box ratios 

will not be reported. 

Circularity Minimum: Specifies minimum circularity. Dots with smaller 

circularities will not be reported. 

Circularity Maximum: Specifies maximum circularity. Dots with larger 

circularities will not be reported. 

Roughness Cutoff (high pass): Specifies a value for filtering the contour for 

roughness calculation. Dots never have perfectly smooth, regular curvatures. 

The Roughness Cutoff value is used to distinguish between acceptable contour 

curvature (with a scale larger than the cutoff), and undesirable contour 

roughness (with a scale smaller than the cutoff). 

Save dot contours to text files: Saves information about the outline of each dot 

to a text file. 

Exclude boundary dots: Excludes from the analysis any dot overlapping the 

boundary of the ROI. The areas of such dots cannot be accurately computed, 

and it may be preferable to exclude them. 

Dilation before erosion: Causes the image first to dilate (if the Dilate setting is 

not zero) and then to erode (if the Erode setting is not zero). If this option is 

not selected, erosion is performed before dilation. 

Erode: Specifies a non-negative integer value for erosion (the larger the integer 

the greater the erosion). Erosion “smoothes” the outer edge of a dot, removing 

asperities. If you do not want the dot edge eroded, set this parameter to zero. 

Dilate: Specifies a non-negative integer value for dilation (the larger the integer 

the greater the dilation). Dilation “bridges” broken pieces of a dot and fills in 

voids. If you do not want the dot dilated, set this parameter to zero. 

Save: Saves the current settings. 

Load: Loads settings from a saved file. 

Use default: Applies factory settings. 
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HiliteDot Tool 

 

The HiliteDot tool is used for analyzing highlight dots on a flexographic plate. 

 

To use the HiliteDot tool, you must define an ROI and two sub-ROIs. (Go to Edit | Reset 

Sub-ROIs to activate sub-ROIs, and right-click to position in the main ROI.) Each of the 

sub-ROIs should encompass just one highlight dot and should be positioned on two 

adjacent dots, as shown in the figure below. These two highlight dots establish the pattern 

for finding all the dots in the main ROI. 

 

The HiliteDot tool is especially useful when the image to be analyzed features small 

highlight dots and also contains, in the “valleys” between the dots, artifacts of similar size 

and shape, as illustrated below. With the regular FlexoDot tool, such artifacts can be 

erroneously interpreted as printing dots. 

 

 
 

Based on the pattern established by the adjacent dots in the sub-ROIs, the software is able 

to find the printing dots in the main ROI and ignore the artifacts in the image. 

To access the HiliteDot tool, select Tools | HiliteDot or click the HiliteDot tool on the 

analysis toolbar.  

To change HiliteDot tool input parameters, right-click on the HiliteDot tool icon or select 

HiliteDot from the Options menu. 

The HiliteDot tool reports the following metrics: 

1. Main ROI 
All dots inside this 

region will be 

analyzed. 

2. Sub-ROIs 
Draw sub-ROIs 

around two adjacent 

dots. 
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Area (mm²/µm²): The area of the dot. 

Diameter (mm/µm): The equivalent circular diameter of the dot, given by: 

A
D

4
, where A = area 

Perimeter (mm/µm): The length of the outside boundary of the dot. 

BoxRatio: The height-to-width ratio of the bounding box of the dot. 

Circularity: Circularity of the dot. The degree of circularity is given by:  

)4(2 ApC , where p = the perimeter length and A = area 

 Note that a circularity of 1 denotes a perfectly circular dot. Dots of any other 

shape will have a circularity greater than 1. For very small dots, the circularity 

measurement may be inaccurate, giving a value of less than 1. 

XCentroid (mm/µm): The horizontal coordinate of the dot centroid. 

YCentroid (mm/µm): The vertical coordinate of the dot centroid.  

XMidpoint (mm/µm): The coordinate of the horizontal center of the dot’s bounding 

box. 

YMidpoint (mm/µm): The coordinate of the vertical center of the dot’s bounding 

box. 

BoundLeft (mm/µm): The left coordinate of the dot’s bounding box. 

BoundTop (mm/µm): The top coordinate of the dot’s bounding box. 

BoundRight (mm/µm): The right coordinate of the dot’s bounding box. 

BoundBottom (mm/µm): The bottom coordinate of the dot’s bounding box. 

BoundWidth (mm/µm): The width of the dot’s bounding box. 

BoundHeight (mm/µm): The height of the dot’s bounding box. 

RMS Roughness (mm/µm): The roughness of the dot contour, using an RMS 

calculation and the specified high-pass filter cutoff. 

Red (%): The average reflectance of the dot in the red channel of the image. 

Green (%): The average reflectance of the dot in the green channel of the image. 

Blue (%): The average reflectance of the dot in the blue channel of the image. 

Spacing (mm/µm): The average spacing in an AM (amplitude modulated) dot 

pattern. 

Ruling (lpcm): The number of lines per centimeter in an AM (amplitude modulated) 

dot pattern. 

Ruling (lpi): The number of lines per inch in an AM (amplitude modulated) dot 

pattern. 

Screen Angle (deg): The screen angle in an AM (amplitude modulated) dot pattern. 
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Dot Percent (%): The dot percent in an AM (amplitude modulated) dot pattern. If 

the dots are darker than the field, it is assumed that they occupy an unprinted area, 

so small dark dots correspond to a large dot percent value. If the dots are lighter 

than the field, it is assumed that they occupy a printed area, so small light dots 

correspond to a small dot percent value. 

HiliteDot Settings 

 
 

HiliteDot settings are as follows: 

Color: Specifies the Color Plane to use for dot analysis. 

Threshold Type: Specifies Absolute or Relative thresholding. Relative threshold 

values are relative to the content of the ROI. 

Polarity: Specifies whether the dots are darker or lighter than their background. 

Units: Specifies the units (mm/µm) used for reporting length and area values. 

Threshold: Specifies the threshold used for locating dot edge boundaries. 

Filter Dots By Diameter: Turns on the dot size filter. 

Filter Dots by Box Ratio: Turns on the box ratio filter. 

Filter Dots By Circularity: Turns on the circularity filter. 
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Auto Size: Turns on automatic size filtering. To use automatic size filtering, 

select both Auto Size and Filter Dots by Diameter. The Diameter Minimum 

and Diameter Maximum values are ignored when Auto Size is selected. 

Diameter Minimum: Specifies minimum dot diameter. Dots of smaller diameter 

will not be reported. 

Diameter Maximum: Specifies maximum dot diameter. Dots of larger diameter 

will not be reported. 

Box Ratio Minimum: Specifies minimum box ratio. Dots with a smaller box 

ratio will not be reported. 

Box Ratio Maximum: Specifies maximum box ratio. Dots with a larger box ratio 

will not be reported. 

Circularity Minimum: Specifies minimum circularity. Dots with a smaller 

circularity will not be reported. 

Circularity Maximum: Specifies maximum circularity. Dots with a larger 

circularity will not be reported. 

Roughness Cutoff (high pass): Specifies a value for filtering the contour for 

roughness calculation. Dots never have a perfectly smooth, regular curvature. 

The Roughness Cutoff value is used to distinguish between acceptable contour 

curvature (with a scale larger than the cutoff), and undesirable contour 

roughness (with a scale smaller than the cutoff). 

Save dot contours to text files: Saves information about the outline of each dot 

to a text file. 

Exclude boundary dots: Excludes from the analysis any dot overlapping the 

boundary of the ROI. The areas of such dots cannot be accurately computed, 

and it may be preferable to exclude them. 

Dilation before erosion: Causes the image first to dilate (if the Dilate setting is 

not zero) and then to erode (if the Erode setting is not zero). If this option is 

not selected, erosion is performed before dilation. 

Erode: Specifies a non-negative integer value for erosion (the larger the integer 

the greater the erosion). Erosion “smoothes” the outer edge of a dot, removing 

asperities. If you do not want the dot edge eroded, set this parameter to zero. 

Dilate: Specifies a non-negative integer value for dilation (the larger the integer 

the greater the dilation). Dilation “bridges” broken pieces of a dot and fills in 

voids. If you do not want the dot dilated, set this parameter to zero. 

Save: Saves current settings. 

Load: Loads settings from a saved file. 

Use default: Applies factory settings. 
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Area Tool 

 

 
Use the Area tool to measure the properties of large solid-color areas. The ability to print 

solid areas of uniform and accurately-calibrated density is critical to producing pleasing 

images. Solid-color areas can reveal deficiencies in the performance of an imaging 

system.  

To modify Area tool parameters, right-click on the Area Tool button or select Area from 

the Options menu. 

Typically, the following area metrics are reported for all color coordinates within the 

ROI:  

Mean: The average color coordinates for all pixels in the ROI. 

StdDev: The standard deviation of the color coordinates for all pixels in the ROI. 

Graininess: Solid-area graininess in the specified color plane. Graininess refers to 

irregular fluctuations of density at a spatial frequency less than a specified tile 

size. It is calculated according to the ISO-13660 International Print Quality 

protocol, which uses a tile size of 42.3µm. 

Mottle: Solid-area mottle in the specified color plane. Mottle refers to irregular 

fluctuations of density at a spatial frequency greater than the specified tile size. It 

is calculated according to the ISO-13660 International Print Quality protocol, 

which uses a tile size of 1270 µm.  

Note that by default FlexoIAS-II uses a tile size of 423 µm which is smaller than 

the ISO-13660 specification, but using a smaller tile size provides better 

sensitivity to smaller-scale non-uniformity. Users can set this tile size according 

to their needs. 
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Area Settings 

 

Area settings are as follows: 

Grain Tile Size [µm]: The low-pass filter for computing graininess. 

Mottle Tile Size [µm]: The low-pass filter for computing mottle. Variations 

smaller than this value do not contribute to mottle.  

Save: Saves data to a user-specified file. 

Load: Retrieves settings from a saved file. 

Use default: Applies factory settings. 
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Setup Menu 

 

 
 

The Setup menu contains the following commands:  

New Plate Settings: Saves new plate settings to a user-specified file. 

Load Settings: Retrieves settings from a saved file.  

Calibration Tolerances: Specifies transmission target value and calibration 

tolerance. 

Calibrate: Adjusts the brightness of the sensor. 

Verify: Verifies the calibration. 

Process Control:  Places the system in process control mode for automated testing. 
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Help Menu 

 

The Help menu contains the following command:  

About FlexoIAS-II 

Use the About FlexoIAS-II command to display the copyright notice and version 

number of the FlexoIAS-II software. 
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QEA Customer Support 

Questions? 

For questions relating to the FlexoIAS-II, several resources are available to you. 

 

First, this FlexoIAS-II User’s Guide. The User’s Guide can help you navigate through the 

FlexoIAS-II features and functions and show you how to use the system. We request that 

you read it carefully. It will probably answer your questions. 

 

If you need further help, please contact QEA by email at support@qea.com. Email 

communications help us serve you better. We will respond to your specific questions with 

detailed instructions.  

 

If more help is needed, we can be contacted at +1 978-528-2034. Ask for FlexoIAS-II 

technical support. Staff availability for telephone support is limited, so before calling 

please let us try to resolve your questions by email. 

Returning Materials 

If you must return the FlexoIAS-II or its accessories to QEA, you must first obtain a 

Return Material Authorization (RMA) number from QEA. If your unit needs to be 

returned for repair, our technical support staff will assist you by providing an RMA 

number and the shipping address to use. Shipping charges for returned materials must be 

pre-paid. No COD shipments will be accepted. 

Replacement Parts 

Replacement parts and accessories for the FlexoIAS-II can be purchased from QEA. 

Please email your request to support@qea.com. Please note that a replacement fee is 

charged for any lost accessories.  

  

mailto:support@qea.com
mailto:support@qea.com
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Appendices 

Appendix A: Sequence Programming Guide 

This appendix describes the sequence programming features included in FlexoIAS-II 

systems with process control capability, such as FlexoIAS-IIPC, FlexoIAS-IIPCP and 

FlexoIAS-IIPC2P. If you have the basic FlexoIAS-II, which does not include process 

control, sequence programming is not included. 

 

With FlexoIAS-IIPC systems, you can create measurement sequences that automate 

testing for process control purposes. 

 

This appendix will introduce you to sequence programming by leading you through the 

creation of a sequence to measure a tone sweep. The procedures demonstrated apply to 

any of the analysis tools. 

 

I. Programming a Sequence 

Creating a Sequence comprises a number of steps: 

1. Opening a new sequence 

2. Specifying Analysis Steps for the new sequence 

3. Replicating Analysis Steps within the sequence as needed 

4. Creating a Database for the results of the sequence 

Creating a new sequence 

1.  Click on View | Sequence Design View. 

 

This switches the software into Sequence Design View mode, giving you access to 

the tools needed for creating the new test sequence. 

2. Click on Sequence | New Sequence. 
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This opens the new sequence, ready for programming. 

3.  Click on Sequence | Save Sequence As…   

 
This opens a dialog box where you can name the new sequence and navigate to 

where you want it saved. 
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4.  Name the sequence “Control Strip” 

 
 

5.  Click Save to save the sequence. 
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Adding an Analysis Step 

Each analysis step does the following: 

 Defines a Region of Interest (ROI) for the analysis 

 Captures an Image 

 Prompts the operator to move the FlexoIAS-II measurement head to a 

specified location 

 Performs the defined analysis on the specified ROI of the captured image 

 

1. Click on Sequence|Add Step 

 

2. This will add an undefined step for analysis. 

The ROI that appears is a placeholder. Its position and size are not important. 

 

3. Double Click on the highlighted ROI to open the Sequence Step Window. 
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4. Enter a Title for the analysis (“2 Percent”). 

5. Enter a Prompt (“Position FlexoIAS-II on 2% Patch”). The prompt will tell the 

operator what to do as the sequence runs. 

6. Select a 70% ROI for the analysis.  

7. Select the analysis you want your sequence to run at this step. 

8. Click on Settings to change the settings for the selected analysis tool.  

Refer to the Tools and Options menus in the main body of the User’s Guide for 

complete descriptions of analysis settings. 

9. Click OK to close the Settings Window. 
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10. Click OK to close the Sequence Step Window. 

11. Repeat the steps above for each new analysis. 

Adding an Analysis Step Using the Duplicate feature 

Often the same analysis may be performed at multiple locations on a sample. Density, 

for example, might be measured in several regions of interest on the same sheet. 

Sequence programming provides a useful feature for duplicating steps that have 

already been defined, allowing additional steps requiring the same analysis to be 

created with ease. 

1. Using the arrows on the command toolbar to navigate among steps already 

created, highlight the step you want to reproduce. In this case, we want to produce 

two additional copies of Step 1, so highlight Step 1. 

 

2. Click on Sequence|Duplicate Step. 
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This will open the Duplicate Sequence Step Window. 

 

3.  In the Columns field, enter the total number of times you want the highlighted 

step to occur in the sequence, including the current instance. The figure above 

shows that there will be a total of three iterations of this step in the sequence, so 

the existing step must be duplicated twice. 

4. Click OK to trigger the duplications. There are now three iterations of this step in 

the sequence. 
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5.  Using the arrows on the command toolbar, navigate through the steps of the 

sequence until Step 2 is highlighted. This is the first of the additional copies you 

just created. 

 

6.  Click on the hammer icon in the toolbar.  

 

7.  The Sequence Step window for Step 2 will open. 

 

8. Rename the analysis (“30 percent”). 

9. Change the Analysis to FlexoDot 

10. Change the prompt telling the operator what to do (“Position FlexoIAS-II on 30% 

Patch”). 
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11. Repeat the process to highlight and rename the remaining iteration of this step and 

change the operator prompt. 

12. Click on Sequence|Save Sequence. 
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Creating a Database 

1.  Click on Sequence|Data Management. 

 

2.  The Sequence Data Management Window will open. 

 

3.  Click on the Browse button next to “Database File:” 
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4.  Create a Database called “Dot Measurement Database”, and navigate to where 

you want it saved. 

5. Click Open. 

 

6.  When prompted, click Yes to create a new database. 

7. The “Database File:” path will be updated with the database you just created. 

 

8.  Click on the Sequence Step drop down menu. 

9. Select Step 1: 2 Percent (HiliteDot). 
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10.  Scroll down and select “Dot Percent (%) Mean” from the Available Fields list. 

11. Click on the arrow icon  to move the selected field to the Selected Fields list. 

 

12.  Change the Label for the first step in “Selected Fields” from “Field1” to 

“Dot%_2.” 

11 
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13.  Repeat steps 9-12 for each of the remaining steps.   

Change the Label for Step 2 to “Dot%_30” and for Step 3 to “Dot%_50”. 

 

14. Click OK to close Sequence Data Management. 

15. Save the sequence by selecting Sequence|Save Sequence. 

16. End your sequence design session by clicking again on View|Sequence Design 

View to deselect it.  
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II. Running a Sequence 

Follow the steps below to run your sequence. 

1.  Click the Process Control button. 

 

2.  Position the FlexoIAS-II on the 2% Patch, as prompted. 

 

3. Position the 2 sub-ROI’s on adjacent dots, as shown 

 

4. Click OK to run the Hilite Dot analysis. 

5. Review the results and click OK. 

a. If the values do not seem reasonable, click Back to repeat the 

measurement. 

b. If the values are reasonable, proceed to the next step. 
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6. Reposition the FlexoIAS-II as prompted. 

7. Click Measure. 

8. Repeat steps 4-7 until all of the patches have been measured. 

 

9. Click Finish to save the measurements to the database. 
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Appendix B: Data Reporting Add-in 

This Appendix describes an optional IASLab data reporting component that is a 

feature of FlexoIAS-II systems with process control capability, such as FlexoIAS-

IIPC, FlexoIAS-IIPCP and FlexoIAS-IIPC2P. If you have the basic FlexoIAS-II, 

which does not include process control, the data reporting add-in is generally not 

included.  

 

The data reporting add-in is a customization that runs on Microsoft Excel to facilitate 

generation of reports using data from the Microsoft database files created by FlexoIAS-

IIPC systems. 

 

Installation 

Installing the add-in requires 3 steps: 

1. Installing the add-in to make it available to Excel 

2. Loading the add-in 

3. Activating the add-in 

Installing the Add-In 

To make the add-in available to Excel, simply place a copy of the file “IASLab.xla” in 

any convenient folder on your computer hard drive. Once you have placed the file in the 

appropriate folder, go to the Tools menu and choose Add-Ins.... (In Excel 2007, click the 

Office button; choose Excel Options; select the Add-Ins screen; choose Excel Add-Ins in 

the Manage input box; and click Go.) In the Add-Ins dialog box, click the Browse button. 

This will open a familiar Open File dialog box. Navigate to the folder in which you saved 

the .xla add-in file, select that file, and click Open. This will install the add-in. Generally, 

you need to do this only once, the first time you use the add-in. 

Loading the Add-In 

After an add-in has been installed, it must be loaded in order to make its functions and 

tools accessible. Open the Add-Ins dialog box as described above and locate the add-in in 

the list. Select the add-in, check the box next to it, and click OK. To unload an add-in, 

follow the same steps, but uncheck the box next to the add-in. 

Activate the Add-In 

Finally, when the add-in loads you will be presented with a “challenge code”. This code 

must be supplied to QEA. QEA will supply a password corresponding to the challenge 

code. You need to enter the password only once to activate the add-in; after that, it is 

ready to use. 

 

After the add-in has been activated, a new “IASLab” menu will appear in Microsoft 

Excel’s main menu. In Excel 2007, an “IASLab” menu command will appear in the 

“Menu Commands” panel of the “Add-Ins” ribbon. 
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Report Generation 

To generate a report, simply select Generate Report from the IASLab menu. 

1. Use the familiar File Open dialog box to select the database file where the raw 

data are stored. 

2. Use the File Open dialog box to select the report template file (discussed below) 

that defines the content and format of the report. 

3. Depending on the design of the report template, you may be prompted for other 

input. Follow the on-screen prompts. 

How it Works 

The following actions are performed by the IASLab Add-In to generate a report: 

1. A new workbook is created based on the specified Excel template file. This new 

workbook will be modified as your report. 

2. The software checks each worksheet in the report to determine whether it includes 

a query definition. The query definition is identified by a cell with the name 

“QUERY_DEFINITION”. There will be a separate worksheet for each query. 

There can also be many worksheets with no query definitions. For each sheet 

where a query definition is found, the corresponding query is executed against the 

specified database file, and the returned records are put into the worksheet. 

3. After the queried data are put into the worksheets that contain query definitions, 

the workbook recalculates, and all the tables, plots and other representations of 

the data are updated to produce the final report. 

Template Design 

The report format and supporting queries are contained in the report template file (*.xlt or 

*.xltx). To create a new template, start with an existing template, make appropriate 

changes, and then save it as a template (*.xlt or *.xltx) with a new filename. 

The mechanism for porting data from the database file to the template-based workbook is 

the query. There must be a separate sheet in the template for each query. To add a new 

sheet with a query to a template, simply make a copy of an existing query sheet, and then 

change its name and contents. 

Rows 4 through 7 of each query sheet define the query that will be run to get data from 

the database: 
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Specifying the fields for the query 

To query for a specific field in the database, enter the table name in cell B4 and the field 

name in cell B5. Note that the syntax of the query must match the database exactly, 

including spelling and capitalization of each table and field name. Since precision is 

essential, it is recommended that you open the database in Microsoft Access, copy the 

relevant table to the Windows clipboard, and then paste it into a temporary Excel 

workbook. Then you can copy and paste the field names from the temporary workbook 

into the query worksheet you are modifying, guarantying that the field names are 

identical to the ones in the database.  

Additional fields are specified in the same way: put the table name in row 4 and the field 

name in row 5. One query (one sheet in the template) can include fields from only one 

table. In other words, on a single query sheet all the table names in row 4 should be the 

same. You can query for as many fields as you want from a single table; the add-in will 

end the query at the first blank cell in row 4. 

Sorting the returned records 

When the query runs, the order of the returned records is unpredictable unless one or 

more of the fields are used to sort the records. Note that in row 6 you can specify fields to 

use for sorting, as follows: 

1. (blank) 

Leave the cell in row 6 blank, and the corresponding field will not be used to sort 

the records. 

2. ASC 

Enter “ASC” in the cell in row 6, and the records in the corresponding field will 

be sorted in ascending order. 

3. DESC 

Enter “DESC” in the cell in row 6, and the records in the corresponding field will 

be sorted in descending order. 

More than one field can be used for the sort. For example, you may want to do a primary 

sort on “Last Name” and a secondary sort on “First Name”, in case “Last Name” is the 

same in multiple records. To do this, just put the desired keyword (ASC or DESC) in row 

6 of the Last Name and First Name fields, and be sure the primary sort column is to the 

left of the secondary sort column. Likewise, more than two fields can be used. Keep in 

mind that sort order is from left to right in the query sheet. 
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Adding filters to the query 

Typically you need to add filtering to the query so that only relevant records are returned. 

For example, the “Area Summary” table of a database may include records from 

uniformity measurements, tone reproduction measurements, various tone sweeps in 

various colors, and results from many different samples. To obtain only the records 

corresponding to a single sample and a single region, you will need to specify some 

filters. 

In row 7 of the query sheet, you can enter any SQL criteria, including the “Like” 

operator, wildcards, and the Boolean operators OR and AND. Examples include: 

=”printerX” 

>15 

<2 

Like “DMa_” 

>2 AND <5 

 

Note that literal text strings used as arguments for Boolean expressions must be enclosed 

in quotation marks. You can specify filters for multiple fields in the query sheets. 

There are also 3 keywords that can be used in the Filter Criteria. They are: 

1. MAX 

When Filter Criteria is keyword MAX, the records will be filtered so that only the 

records with the given field at its maximum value will be returned. You can use 

the MAX keyword with the field SampleRecID to produce a report from the most 

recently analyzed sample. 

2. INPUT 

When Filter Criteria starts with keyword INPUT, the user is prompted for the 

value of the given field. Follow keyword INPUT with the prompt for the user. 

3. SELECT 

When Filter Criteria starts with keyword SELECT, the user is prompted to select 

the value for the given field from among all the values in the database. Follow 

keyword SELECT with the prompt for the user. 

Using results from one query to filter a second query 

It is often convenient to use the results from one query to filter a second query. For 

example, if SELECT (see above) is used to allow the user to select a single sample ID in 

a query (an independent query), the results of that independent query can be used to filter 

the records from other queries (dependant queries) in the workbook. It is important that 

the independent query be run before the dependant queries. To mark a query as 

dependant, simply put the field with the dependant filter in column B (the first column), 

and for the criteria (cell B7) enter an Excel expression like this: 

 

=”=”&SampleLog!B12 
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…where the sheet “SampleLog” contains the independent query. Note that before the 

independent query runs, the cell SampleLog!B12 is blank, so this expression evaluates to 

the equal sign (“=”) When the add-in sees the single equal sign in cell B7, it recognizes 

the sheet as a dependant query and postpones running it until after all the independent 

queries have been run. Only then do the dependent queries run, with the appropriate 

filters. 

Presentation of results 

Typically a report includes summarized results and graphical presentations such as charts. 

The easiest way to develop these report features is to first create a simple template with 

queries only. Then select this template as the basis for a report with real data. With the 

resulting workbook, you can add worksheets and format them to present the data as 

desired.  

You can create a template from a report by making a new copy of the report and clearing 

the data from the query sheets (select all the rows after row 8 and clear contents). Be sure 

not to alter the query definitions in rows 4 through 7; just clear the data. Do not delete the 

rows or cells, just clear their contents. Finally, save the workbook as a template and use it 

with the add-in to generate reports with the desired formatting. 
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Appendix C: Engineer’s Standard Operating Procedure  

The engineer or system supervisor, in addition to providing general supervision, review 

and analysis of results, and technical support in the use of the FlexoIAS-II, is responsible 

for performing system calibration. The following is a step-by-step calibration procedure. 

 

Steps Actions Results 

1) Turn on 

hardware 

 
Turn on light box. 

 
Light shines from the top; the green 

LED is on. 

2) Launch 

software 

 
From the Start menu select All 

Programs|FlexoIAS-II.exe 

 

 
Click OK. 

FlexoIAS-II loads; user interface 

appears. 
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Steps Actions Results 

3) Set 

Calibration 

Tolerances 

This action is performed once, when 

the FlexoIAS-II software is installed 

or reinstalled 

 

From the Setup menu, select 

Calibration Tolerances… 

 
Verify that the tolerances are set to  

   Transmission Target Value =  80% 

   Calibration Tolerance   =  ±1.0% 

   Verify Tolerance              =  ±2.0% 

Click OK. 

 

Tolerances are set to provide 

Pass/Fail feedback during both the 

calibration and verification 

processes. 

4) Set up 

Measurement 

Database 

This action is performed once, when 

the FlexoIAS-II software is installed 

or reinstalled. 

 

Select File|Data Logging… 

In the Measurement Database field 

enter the name of the database where 

plate data is to be recorded. Click 

OK. 

 
 

All calibration and verification data 

will be recorded in the selected 

database. 
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Steps Actions Results 

5) Calibration Calibration is performed under two 

conditions: 

1) When FlexoIAS-II software is 

installed or reinstalled 

2) When the system fails the 

verification test 

Make sure the light box has been on 

for at least 5 minutes prior to 

calibration. 

 
Note: The Transmission Reference 

Standard should be cleaned with 

compressed air when necessary. It 

should be stored in its case in a clean, 

dry place when not in use. 

 

Select Calibration|Calibrate… 

 
Place the Transmission Reference 

Standard (label-side up) on the light 

box underneath the Measurement 

Unit.   

 
Then click OK. 

 

 

 
During calibration, the software will 

open a series of windows as it adjusts 

the camera settings. Beeps may be 

heard. When calibration is complete, 

all of the windows will close and the 

image pane will contain a white 

image of the Transmission Reference 

Standard surface. 

BE PATIENT: this procedure may 

take more than 2 minutes to 

complete. DO NOT disturb the 

computer or switch to other 

applications during this process. 

 

 
At the end of the process, a dialog 

box will display a PASS/FAIL 

indicator. In the case of a failure, 

repeat the calibration. 

 

Click OK. 

 

Due to camera limitations, it may be 

necessary to repeat the calibration 2 

or 3 times to get a successful 

calibration. 
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Steps Actions Results 

6) Load 

Settings 
For automated Process Control 

Measurements, a previously defined 

measurement sequence must be 

loaded. 

See Appendix A above for a detailed 

explanation of how to create a 

sequence. 

Select Load Settings from the 

Command Toolbar 

 

Select a previously defined sequence 

and click Open. 

 
 

The FlexoIAS-IIPC software will 

load the sequence. 

The name of the loaded sequence is 

displayed on the Status Bar at the 

bottom of the window. 
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Appendix D: Operator’s Standard Operating Procedure  

Routine Use of the FlexoIAS-II for Process Control 

 

Steps Actions Results 

1) Turn on 

hardware 

 
Turn on light box. 

 
Light shines from the top; the green 

LED is on. 

2) Launch 

software 

 

From the Start menu, select All 

Programs|FlexoIAS-II.exe 

 

Click OK. 

 

 

FlexoIAS-II software loads; the user 

interface appears. 
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Steps Actions Results 

3) Check 

instrument 

stability 

 

Perform this operation at the 

beginning of each shift. 

Light box should be on for at least 5 

minutes before performing this step. 

 

Retrieve your Transmission 

Reference Standard from its storage 

location. Make sure it is clean; clean 

it with compressed air if needed.  

Click the Verify button. 

 
 

 

Place the Transmission Reference 

Standard (label-side up) on the light 

box underneath the Measurement 

Unit.   

 

Then click OK. 

 

The software displays a PASS/FAIL 

indicator. 

 

Enter your name in the Operator box. 

Click OK. 

 

If the system returns a FAIL 

indicator, verify that: 

1) Transmission Reference 

Standard, Measurement Unit 

and light box aperture are 

clean 

2) Light box is warmed up 

If the verification fails repeatedly, 

have the Engineer perform a 

calibration. 



FlexoIAS™-II Flexographic Plate Measurement System 

© Quality Engineering Associates, Inc. 81 

Steps Actions Results 

4) Position 

Control Strip  

 

The flat side of the FlexoIAS-II 

Control Strip must rest against the 

top of the light box. 

 

Use the Control Strip Alignment 

Guide to help position the FlexoIAS-

II Control Strip over the light box 

opening. 

 

 

 

 

 

 

 

 

 
 

 

The control strip patch should be 

centered on the opening in the light 

box. 

 

5) Position the 

FlexoIAS-II 

 

Place the FlexoIAS-II in the center 

of the Control Strip Alignment 

Guide, on top of the FlexoIAS-II 

Control Strip. 

 

The patch is clearly visible with no 

black areas around the edges. 

Light box 

Control Strip 
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Steps Actions Results 

6) Start 

Measurement of 

FlexoIAS-II 

Control Strip 

Click the Process Control button. 

 
 

 

 

A message box appears prompting 

you to position the first patch over 

the opening in the light box. 
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Steps Actions Results 

7) Measure a 

Highlight Patch 

 

Position the highlight patch over the 

light box aperture and place the 

FlexoIAS-II on top. 

Press the orange button on the left 

side of the Measurement Head to 

capture an image. 

 

Using the right mouse button, 

reposition the sub ROIs around two 

adjacent PRINTING dots as shown. 

Click OK to perform a highlight dot 

measurement. 

Verify that the correct dots have 

been found, and click OK. 

 

Verify that the printing dots are 

circled in red. 

Make sure the line screen value is 

reasonable. It if is too high or too 

low, the wrong dots have probably 

been found. 

Also check Dot Percentage to make 

sure it is reasonable, e.g. <5%. 

The software will return to Preview 

Mode when you click OK. 
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Steps Actions Results 

9) Measure a 

Midtone Patch 

 

Position a midtone patch under the 

FlexoIAS-II. 

Press the orange button on the left 

side of the measurement head to 

capture an image. 

Click the Measure button to 

perform a dot measurement. 

Verify that the correct dots have 

been found, and click OK. 

 

Verify that the printing dots are 

circled in red. 

Verify that the line screen value is 

reasonable. It if is too high, the 

wrong dots have probably been 

found. 

Also check Dot Percentage to make 

sure it is reasonable. 

The software will return to Preview 

Mode when OK is clicked. 

 

10) Repeat 

Measurements 
Following the example in step 9, 

repeat the dot measurements on the 

remaining patches. 

When prompted, click Finish to 

write the results to the measurement 

database. 

 

When the sequence is completed, the 

results will be displayed in the results 

pane of the FlexoIAS-II software. 

 

Click Finish to write these results to 

the database. 

 

 


